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Quick Start

MILL Module 2026
Prefer Printed Documentation? Click Here!

What's New  |  Quick Start Play List 

Quick Start Guides for each VisualCAD/CAM module are available in both PDF and Video format. 
Refer to the following information to access these resources:

What's New!

What's New in VisualCAD/CAM 2026

The Complete Quick Start Video Play List

Here is a link to the complete 2026 Video Play List

How to Access the Quick Start Guide Documents

To help you quickly get started in working with each module, select one of the Help
buttons located on the VisualCAD/CAM Learning Resources dialog.  

You will find:

· Quick Start Guides  

· What's New documents  

· Online Help links

The Quick Start Guides will help you step through an example tutorial which will
illustrate how to use the module.  To access the Learning Resources dialog:

1. From the VisualCAD Home Ribbon Bar, drop down the Main menu and select Learn ...  

https://mecsoftcorp.github.io/VisualCADCAM-2026/Resources/VisualCADCAM2026-Resource-Guide.pdf
https://mecsoft.com/WhatsNew/WhatsNewInVisualCADCAM2026.pdf
https://www.youtube.com/playlist?list=PLx9G05pFm0QISEAjFqPkrNRyUTOYw9ZRZ
https://mecsoft.com/WhatsNew/WhatsNewInRhinoCAM2026.pdf
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To access the Learning Resources dilog in VisualCAM

2. Select a document from the Learning Resources dialog to get started using the
module of your choice.  

 You can also select the Open Quick Start Files Folder button located at the bottom
of the dialog to open the Quick Start folder where the source files (start and
completed versions) are located.
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Learning Resources Dialog
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Resource Guide

Download this PDF Guide for a list of the available VisualCAD/CAM Resources.

2025 VisualCAD/CAM Resource Guide

The 2026 VisualCAD/CAM Resource Guide!

18 Pages

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

Prefer Printed Documentation? Click Here!

What's New  |  Quick Start Play List 

https://mecsoftcorp.github.io/VisualCADCAM-2026/Resources/VisualCADCAM2026-Resource-Guide.pdf
https://mecsoftcorp.github.io/VisualCADCAM-2026/Resources/VisualCADCAM2026-Resource-Guide.pdf
https://mecsoft.com/WhatsNew/WhatsNewInVisualCADCAM2026.pdf
https://www.youtube.com/playlist?list=PLx9G05pFm0QISEAjFqPkrNRyUTOYw9ZRZ
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Avoid Fixtures in 2 Axis

If you have fixtures holding your stock onto your CNC table, you can avoid them automatically
during all 2½ Axis toolpath operations. To implement this, follow the outlined steps below:

1. In the CAD system (Rhino or VisualCAD) create a 3D solid model of each fixture and position
them in the locations that they will appear in the actual setup on your CNC table.

2. If you currently do not have any 3D fixtures defined in RhinoCAM or VisualCADCAM, under
the Machining Job tree, right-click on the Fixture icon and select New Fixture from the
menu. You will be prompted to select the 3D objects representing each fixture. They must
be 3D solid (i.e., closed poly-surfaces). Do so and then press enter.  This will display the
Create Machining Fixture dialog.
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3. Your selected fixtures will be listed in the Fixture Geometry list.

4. You can specify a Fixture Clearance Distance if desired.

5. Pick Save to close the dialog.

6. Your fixture will appear in the Machining Job tree.
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7. Your fixtures are now defined but they are not yet applied to your setup.

8. Now, double left-click on the Setup icon in the Machining Job tree where you want the
fixtures to be applied.

9. From the Setup dialog, pick the Select Fixtures for Setup tab.

10. Check the box next to the fixture you to apply to the active setup and pick Save.
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11. Now, for this setup only, toolpaths generated will automatically avoid the fixtures by the
distance specified in Step 4 above. If you have existing operations make sure you regenerate
them.
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Add a Tool Change Point

To output a Tool Change Point to your posted g-code files, please do the following:

1. From the Machine Setup dialog (Program tab > Machine > General Parameters > Tool
Change Pt), enter your required tool change point coordinates.

2. For the sample code (shown at the end of this section) we entered the following values in
the Machine Setup dialog:

X: -4, Y: 0 Z: 0

3. Edit your post processor by selecting Program tab > Post > Edit.

MILL Module shown, Similar for MILL-TURN, TURN and Profile-NEST

4. From the Post Process Generator dialog, select the Tool Change section from the left side
of the dialog.
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5. In the Tool Change Macro block section, replace the first line of text with the following
two lines of text at the top of the macro.  
These two lines of text should precede the line that includes T[TOOL_NUM] as shown in
the examples below.

[SEQ_PRECHAR][SEQNUM][DELIMITER]G0 Z[TOOL_CHG_PT_Z]
[SEQ_PRECHAR][SEQNUM][DELIMITER]G0 X[TOOL_CHG_PT_X] Y[TOOL_CHG_PT_Y]
[SEQ_PRECHAR][SEQNUM][DELIMITER]T[TOOL_NUM]
...
...

6. If your controller expects to see an optional stop call BEFORE each tool change, you can
add another line like below:

[SEQ_PRECHAR][SEQNUM][DELIMITER]G0 Z[TOOL_CHG_PT_Z]
[SEQ_PRECHAR][SEQNUM][DELIMITER]G0 X[TOOL_CHG_PT_X] Y[TOOL_CHG_PT_Y]
[SEQ_PRECHAR][SEQNUM][DELIMITER]M01
[SEQ_PRECHAR][SEQNUM][DELIMITER]T[TOOL_NUM]
...
...

7. From the Post Process Generator dialog, pick Save As.

8. Enter a unique name for your post file (*.spm) for testing and pick Save.

9. From the Set Post-Processor Options dialog, select the revised post from the Current Post
Processor list.
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10. Note: If you do not see your revised post in the list, select the "..." button to the right of
the "Folder where post-processor file are located" and select the folder where you saved
your revised post file to (see Step 7 above) and pick OK.

11. You should now see your revised post in the list.  Select it and pick OK.

12. Post a sample toolpath using the revised post.

13. Review the g-code test file and locate the first tool change lines of code. 

14. Your sample test should look something like this depending on your post (based on the
tool change point we used in Step 2 above).  Note the tool change coordinates in blue:

...

...
N66 ;2 1/2 Axis  Profi l ing
N68 G0 Z0.
N70 G0 X-4. Y0.
N72 T1 M06
...
...

15. That's it!
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Add more Materials

This topic is intended for advanced users who are familiar with XML text editing and have
administrative access to their Windows Operating System.  VisualCAD/CAM has a built-in Feeds &
Speeds Calculator that can suggest Spindle Speeds and Cut Feed Rates based on your stock
material and active tool parameters!  

However, what if you are cutting stock material that is currently not in our Materials Library?  Or
what if you don’t like what is currently assigned for the material of your choice in the Materials
Library?  

This topic will show you how to customize VisualCAD/CAM to add and manage multiple material
files as well to add your own stock materials.  If you are new to VisualCAD/CAM, you can review
the topic The Feeds & Speeds Calculator.

How Materials are used

First let’s review how material definitions are used in VisualCAD/CAM.  From the Stock
pane of the Program tab in the Machining Browser you will find the Material icon. 
Selecting it will display the Select Stock Material dialog.  Here you can select a stock
material from the Material File.  If there is an associated Material Texture file, then this
texture is assigned to the stock model and rendered in the graphics window.  This
texture rendering on the stock can be toggled on or off using the Material Texture
Visibility icon, located at the base of the Machining Browser.

MILL Module shown, Similar for MILL-TURN,
TURN and Profile-NEST

The Material icons in the Machining Browser /
MILL Module shown, Similar for MILL-TURN,

TURN and Profile-NEST The Select Stock Material dialog
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Also, from the Feeds & Speeds tab on the Create/Select Tool dialog you can select Load
from File to display the Feeds & Speeds Calculator dialog.  The Material selection in this
dialog will default to the stock Material you have previously selected from the Select
Stock Material dialog (shown above).

Location of Material Files

The Material selections available to you from these dialogs are retrieved from a Feeds &
Speeds XML file installed with the program.  There are separate files for INCH and
METRIC units.  The files are located in the \Materials folder of the ProgramData install
path of the program.  

Here is an example: C:\ProgramData\MecSoft Corporation\Program Name &
Version\Materials.  

By default, the Windows Operation System does not display the
ProgramData folder to you.  If you do not see it, log in as

Administrator and from the Windows Control Panel, navigate to the
File Explorer Options dialog, select the View tab and then select the
option to Show hidden files, folders, and drives and pick OK.

Maintaining Multiple Material Files

You can create your own Material Files and store them in the default folder.  The CAM
system on startup will load all material files in the folder specified in the dialog above as
long as the units of the material files match the part units that you are working with.  If
the system finds multiple material files with matching units, it will populate the drop-
down control in the Materials dialog allowing you to select a specific material file to suit
your needs.

You need to make sure that you have the units specified correctly
in your customized materials XML files or your material files will

not appear in the dialog list.  See item #5 in the Editing the Feeds &
Speeds XML File section below for the correct Units format.

Having multiple material files can help manage different materials and associated feeds
& speeds data without having to cram all of the data into one file. In addition, multiple
material files may be useful if you have multiple machines in the shop with different
power capabilities and you want to use different feeds and speeds settings per machine.
Under this scenario you could have one material file per machine saved in the default
folder and load the correct material file depending on which machine you are
programming toolpaths for.

Editing the Feeds & Speeds XML File
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Material files can be edited to customize the data stored in these files to suit your shop
needs.

CAUTION!! - Before editing material files - Make sure you create a
copy and keep them in a safe place, outside of the install path of

the program.  Also, make sure you maintain the XML format of these
files or the Feeds & Speeds Calculator may not work properly!  The
file names are:

FeedsSpeedsDataINCH.xml
FeedsSpeedsDataINCH.xml

Here are the steps required to add new material definitions. Be sure to read these steps
carefully:

1. Make a backup copy of the Feeds & Speeds XML files!

2. Edit the XML file to add the material definitions needed, paying close attention
to the format of the XML file.  This file can be edited with any ASCII text editor
such as Notepad or any XML editor.

3. Each Material defined in the XML file has several records (or lines of text)
associated with it.  Each line of text defines information about that Material for
each instance it is referred to by the Feeds & Speeds Calculator.  Here is a sample
section for Aluminum 2026.

<Vers ion>1.0</Vers ion>

<Units>Imperia l</Units>

<FeedsSpeeds>

 <Materia l>

    <Name>ALUMINUM - 2026</Name>

    <TextureFi le>ALUMINUM.bmp</TextureFi le>

    <FeedsSpeedsRecord>MILLING, CARBIDE, 1600.00, 0.0040</FeedsSpeedsRecord>

    <FeedsSpeedsRecord>MILLING, HSS, 400.00, 0.0040</FeedsSpeedsRecord>

    <FeedsSpeedsRecord>MILLING, CERAMIC, 400.00, 0.0040</FeedsSpeedsRecord>

    <FeedsSpeedsRecord>DRILLING, CARBIDE, 960.00, 0.0048</FeedsSpeedsRecord>

    <FeedsSpeedsRecord>DRILLING, HSS, 240.00, 0.0048</FeedsSpeedsRecord>

    <FeedsSpeedsRecord>DRILLING, CERAMIC, 240.00, 0.0048</FeedsSpeedsRecord>

    <FeedsSpeedsRecord>TURNING, CARBIDE, 1800.00, 0.0200</FeedsSpeedsRecord>

    <FeedsSpeedsRecord>TURNING, CERAMIC, 1800.00, 0.0200</FeedsSpeedsRecord>

    <FeedsSpeedsRecord>TURNING, CERMET, 1800.00, 0.0200</FeedsSpeedsRecord>

 </Materia l>

...

...
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Here is what the file looks like in tabulated form:

4. You will need to know the Surface Speed and Feed/Tooth specifications for each
instance of the Material you are adding to the XML file.  Here is the information
format:

<FeedsSpeedsRecord>MILLING, HSS, 400.00, 0.0040</FeedsSpeedsRecord>

5. You need to make sure that you have the Units format specified correctly in your
custom material XML files.  It is defined on the 2nd line of the Materials XML file.
 For Inch units use <Units>Imperial</Units> and for Metric units use
<Units>Metric</Units> as shown here for Inch:

<Vers ion>1.0</Vers ion>
<Units>Imperia l</Units>
<FeedsSpeeds>
<Materia l>
...
...

6. There is also a bitmap image file (*.bmp) associated with each Material type
defined in the XML file.  This image defines the texture that is applied to the
Stock material when the Toggle Material Texture Visibility icon is enabled.  The
image is also displayed in the Select Stock Material dialog.
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Dialog Box: Select Stock Material

Here is the list of the material texture map files currently installed.  Make sure
your bitmap image file name matches the name entered into the Materials XML
file or the No Texture Map icon will display instead.

Let’s Review

Adding specific materials you use regularly in your shop to the Feeds & Speeds Calculator
in VisualCAD/CAM can save toolpath programming time and help ensure cut surface
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quality and machining time accuracy.  Just be sure to review this post carefully.  A
summary is also listed below.  If you need help, you can always contact us at MecSoft
Support via the phone, web or email.

1. You can select a Material to be applied to your Stock definition.

2. The selection of materials are retrieved from an external data file (example:
FeedsSpeedsDataINCH.xml) located in the install path of VisualCAD/CAM on your
computer.

3. The XML data file can be edited with any ASCII text or XML file editor.

4. The XML data file also contains information about the CAM Module, Tool
Material, Surface Speed and Feed/Tooth for each instance of the material.

5. The stock material selected is used by the Feeds & Speeds Calculator to suggest
Surface Speeds and Cut Feed Rates.

6. The Feeds & Speeds Calculator is displayed when you select Load from File from
the Feeds & Speeds tabs of the Create/Select Tool dialog or from each toolpath
operation dialog.

7. You can manually add more materials to the XML data file.  You will need to know
the recommended Surface Speed and Feed/Tooth specifications for the material
you are adding based on each Tool Material type.

8. It is very IMPORTANT that you make a backup copy of these XML files if you plan
to edit them.  Also, the text format of the XML files is VERY IMPORTANT.  If the
format is incorrect, the Feeds & Speeds Calculator may not work properly!  Make
sure that the Units format on line 2 matches the Units you plan to use in your part
files.

9. Each material also has a bitmap image texture file (*.bmp) that is located in the
same folder.  The material texture image is shown in the Select Stock Material
dialog and is also applied as a texture map to your stock when the Toggle
Material Texture Visibility icon is enabled.
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Add Tool Comments

You can add comments associated with a Tool.  These Comments are saved with the Tool in your
Tool Library.  They are also posted to your g-code when the tool is used.  

Here are the steps to add Comments to a Tool:

1. Edit the Tool using the Create/Select Tool dialog.

2. Select the Properties tab on the right.

3. Add text to the Comments window.
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4. Make sure Comments are enabled in your post.

A. Click on Post (Set Post-Processor Options), then click Edit.

MILL Module shown, Similar for MILL-TURN, TURN and Profile-NEST

B. From the Post Processor Generator dialog, select the General tab from the left.

C. Check the box to Output Comments.  You can also change the start and end
characters to use.

D. Then pick Save or Save As.

5. Now post your operations and see your comments:

...

...

G1 X0.5301 Y-0.7171 Z0.7480

G3 X0.7801 Y-0.4671 I0.0000 J0.2500 F2.6

G1 X0.7801 Y-0.2171 Z0.7480 F6.9
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G0 Z0.9843

G0 X0.7801 Y-0.2171 

(2 1/2 Axis Profiling)

(My Tool Comments Here!)

S18000

G0 Z0.9843

G0 X0.5301 Y-0.7097 

G1 X0.5301 Y-0.7097 Z0.7480 F6.9

G1 X0.5873 Y-0.7097 Z0.7480 F3.4

G1 X0.5873 Y-0.6345 Z0.7480

G1 X0.4729 Y-0.6345 Z0.7480

...

...

6. If you want to post g-codes instead of comments, just place a $ character prior to the
comment in the Create/Select Tools dialog.  Adding $ as prefix will skip the comment start
& end characters in the posted code.

...

...

G1 X0.4655 Y-0.7171 Z0.7480

G1 X0.5301 Y-0.7171 Z0.7480

G3 X0.7801 Y-0.4671 I0.0000 J0.2500 F2.6

G1 X0.7801 Y-0.2171 Z0.7480 F6.9

G0 Z0.9843

G0 X0.7801 Y-0.2171 

(2 1/2 Axis Profiling)

My g-code Here!

S18000

G0 Z0.9843

G0 X0.5301 Y-0.7097 
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G1 X0.5301 Y-0.7097 Z0.7480 F6.9

G1 X0.5873 Y-0.7097 Z0.7480 F3.4

G1 X0.5873 Y-0.6345 Z0.7480

...

...
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Align the Stock & Part

If your Stock is not aligned correction with the Part model you can change it.

1. Select the Program tab.

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

2.   Select the Align menu.

3.   Select Align Stock from the menu to display the dialog.

4. First select the Z Alignment by select Top, Center or Bottom.  For our example we will
select Bottom.

5. Then select an XY Alignment option.  Nine different locations are available.  For our
example we will select Center.
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6. The Stock displayed on the screen will move then you make selections from this dialog.

7. Again if you have curves or other non-part wireframe geometry displayed, you can check
the box in the dialog to ignore them when calculating the alignment.

8. Pick OK to close the dialog.

Alternatively you can move the actual part model in relation to the Stock if desired.  IMPORTANT:
This option will physically move the location of your part geometry.  This command is useful when
you have opened or imported part geometry that is NOT in the correct location for machining.

1. Open the part that you wish to align.

2. Define the Stock dimensions and location.  See How to Define a Box Stock for more
information.  Our example part looks like this:

3. Select the Program tab.
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MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

4.   Select the Align menu.

5.   Select Set World C.S. from the menu to display the dialog.

Remember that this dialog will physically MOVE your part geometry!

6. First select an option from the Set WCS Origin section.  This sets the new WCS Origin.  In
this example we select Set to Stock Box.  We want to move the part in relation to the
currently defined Box Stock.

7. Then define the ZERO Face.  This aligns the part in Z.  In this example we select Lowest Z so
the WCS Origin of the part will move in Z to the bottom of the Stock Box.
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8. Then define the Zero Position.  There are nine cardinal directions to choose from.  Each is
in relation to the current Box Stock.  In this example we select South West so the WCS
Origin of the part will move to this position on the Stock.

This is our desired part location:

9. When you pick OK, the part WCS origin will move the location you specified in the dialog.

Related Online Help Topics

User Interface

Align Stock



Assign a Stock Material 29

© 2026 Mecsoft Corporation

Assign a Stock Material

You can optionally assign a Material definition to your Stock.  The Material definition is used for
display purposes.  It will also be automatically fed into the Feeds & Speeds Calculator when it is
displayed.

1. Currently we have a part loaded and stock defined and toggled on.

2. Select the Program tab.

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

3.   Select Material to display the dialog.
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Dialog Box: Select Stock Material

4. Select a Material from the selection menu in the dialog.  A preview of the Material texture
will display in the dialog.

5. Materials are stored in a Material file.  The default Material File is pre-selected from the
menu.  

6. The folder location where the Material File is located is indicated in the field at the
bottom of the dialog.  This location cannot be changed.  

7. In the future you can add material definitions to the Material File or create your own
material file.

8. Pick OK to close the dialog.

9.   To see your selected material display on the stock, select the Toggle Material Texture
Visibility icon located at the bottom of the Machining Browser - second icon from the left. 
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MILL Module shown, Similar for MILL-TURN, TURN and Profile-NEST

Related Online Help Topics

User Interface

Material
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Control the Cut Side & Start Point

Our support staff speaks with users on a daily basis and new
users have many questions.  One of the questions asked
often is:

How can I control the cut side and the cut start point of my 2
Axis toolpaths?

This article addresses this question is detail.  To get many
more of your questions answered be sure to get the
Question & Answer Guide available for each of MecSoft's
CAM desktop Plugins.  As an Annual Maintenance
Subscription (AMS) subscriber, this guide and other training
materials are available to you as part of your annual
subscription.  To learn more about AMS or to become an
AMS subscriber just give us a call at (949) 654-8163 option 1 for Sales or contact
sales@mecsoft.com today.

Each curve has a Start point, Direction and an End point.  The Right Hand side of the curve is
determined by the curve direction.  These definitions are shown in the illustrations below.   In 2
Axis machining methods the Cut Start Point is defined by the Start Point of the selected curve
regions  

So controlling the curve Start Point is critical in controlling the Cut Start Point of the 2 Axis
toolpath.

Understanding Curve Geometry

To answer this question, we must first talk about curve geometry (i.e., line, arc or
spline).  Collectively we will call them curves.  Each curve has a Start point, a Direction
and an End point.  If you position yourself at the start point and face the direction the
curve is traveling, then your right and left hand will govern the right and left side of the
curve.  

These definitions are shown in the illustration below.  In 2-1/2 Axis machining methods
the Cut Start Point is defined by the Start Point of the curve region.  Thus, controlling the
curve Start Point is critical in controlling the Cut Start Point of the toolpath.  For closed
curves, Inside and Outside can be used to control the side to cut.  If the curve is a surface
edge of a 3D solid model, you can also allow the program to determine the correct side
to cut based on the part’s topology.

mailto:sales@mecsoft.com
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The Start Point, Direction and Cut Side of Curves Geometry

When Machining Multiple Curves

When more than one disconnected curve is selected for one machining operation each is
obviously treated as a separate curve region, each with a unique cut start point.  

When multiple curves that are located end-to-end are selected for
one machining operation it is highly recommended that you first

merge or join the curves into one poly-curve.  Doing this first will
define a single cut start point for the entire poly-curve.  

NOTE: If the curves are left disconnected, the start point of the first
curve selected for the machining region will serve as the cut start

point.  You can move a curve to the top of the Selected Machining
Region(s) list and its start point will become the cut start point for the
operation.

Error - open loops found!

If you get an "open loops found!" error message when generating an operation, this
means that the machining regions you have selected are not joined when the operation
is expecting them to be.  2-1/2 Axis Pocketing is one operation that expects closed
curves.  This is why it is always good practice to join closed curves into one poly-curve
before being used in a machining operation.  The following illustrates open loop
conditions:
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How to Identify Start Points in CAD

You can identify and display curve start point and direction arrow indicators using your
CAD system tools and commands.

1. In VisualCAD, go to the Home tab in the top ribbon bar and select the Options

icon.

2. Select Display from the left side of the dialog.  Find the Curve Display Type
section and check both boxes for start point and direction arrow and then pick OK
to close the dialog.

3. Start point and arrow indicators will appear..

How to Change a Curve's Start Point in CAD

You can use your CAD tools to move the Start Point of a curve.  See the section above on
How to Identify Start Points before continuing. 

1. Go to the Curve Modeling tab in the top ribbon bar and select the Change Start

icon .  

2. Select a point on the curve that you want to move the start point to.
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How to Change the Start Point in CAM

In VisualCAD/CAM you can use Pre-Defined Regions to control the Cut Start Point,
Direction and other aspects of your machining regions.  This is a convenient method
because it works on both curves and surface edges.

1.   To the left of the Program tab, select the Tools Machining Objects icon to
make sure the Machining Objects Browser is displayed.

2. Select the Regions tab.

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

3.   Pick the Select Curves icon.

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

4. Select the curves or surface edges that you want to create a pre-defined region
from and then right-click or press <Enter>.  The example below we select the top
outer surface edge.
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5. A Machining Region Set is created and added to the Machining Regions list with
each curve/edge listed.  In this example only one region is created.  It is selected
by default and the regions is displayed on the part with the start point and
direction indicated.

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

6.   With the curve region selected from the Machining Regions list, pick the
Select Start Point icon to enable start point editing.

7. Now select a new start point anywhere along the pre-defined region.  The start
point will move to that location.
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8.   Notice that the Select Start Point icon is still enabled.  You can select
another location for the start point if desired.

9. Take a moment to familiarize yourself with the other cool Region commands on
the toolbar and use them to save time and control your toolpaths.

  Create Machining Region Set

  Select Curve

  Select Surface Edge Areas

  Flat Areas Selection Filter

  Select Flat Areas

  Select Start Point

  Reverse Cut Direction

  Automatic Bridge Points on Selections

  Manual Bridge Points on Selections

  Delete All Bridge Points in Selections
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  Edit Bridge Point in Selections

  Clone Region

How to Select Pre-Defined Regions for a Toolpath

Once you have created a Pre-Defined Region with its Start Point defined you can use
them as machining regions in any toolpath operation.

1. Create a toolpath operation as you normally would.  See How to Generate a
Toolpath for more information.

2. Select the Control Geometry tab.

3.   Pick the Select Pre-Defined Regions button to
display the dialog.

4. Select the region(s) for the toolpath operation and then pick OK to close the
dialog.  You can select one or more regions or a region set.

5. The Pre-Defined Region is added to the list of Selected Machining Region(s).  It is
listed as a Curve Region and can mixed with other curve or drive regions in the
list. 

6. Now Generate the toolpath as you normally would and the Start Point of the Pre-
Defined Region controls the Cut Start Point of the 2 Axis toolpath.  In this
example, it is a Profiling toolpath.
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7. NOTE: If you are generating a 2 Axis Profiling toolpath and your entry IS NOT
being located at the curve start point, go to the Cut Parameters tab and make
sure the option called Use Mid-Point of Longest Side is not checked.  If it is,
uncheck it and Generate the operation again.

Cut Start Point Controls in other Methods

Here is a list of the toolpaths that allow for Cut Start Point control.

1. All 2 Axis toolpath methods.

2. 2 Axis Roughing and 2 Axis Pocketing have an additional Start Points sub-tab on
the Control Geometry tab where you can define Cut Start Points.

3. 3 Axis Horizontal Roughing and 3 Axis Horizontal Re-Roughing also have an
additional Start Points sub-tab on the Control Geometry tab where you can
define Cut Start Points.

4. Other 3 Axis methods have various parameters that control the toolpath so be
sure to review all of the controls on the Cut Parameter tabs for each operation
type. 
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Copy/Edit a Toolpath

Toolpaths can be combined to machine complex objects.  In our How to Generate a Toolpath
example, we showed you how to generate a single 2 Axis Pocketing toolpath.  However, you
might of noticed that example only cut the bottom portion pocket.  There is also a pocket above it
that has different geometry.

Note that all roughing and finishing toolpaths can be generated in any order.  Re-Roughing
requires a previous Roughing toolpath to be generated and simulated first.  However when
completed, it is a good practice to have each toolpath appear in the Machining Job in the order
you plan to machine them.  You can change the order of the toolpaths after you generate them.  

In the example below we create the 2 Axis Pocketing toolpath for the top level of the pocket from
a copy of the previous toolpath.  We will them move it up in the Machining Job.

1. First read How to Generate a Toolpath topic and then proceed.

2. Select the Program tab.

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

3. Select a toolpath from the Machining Job, right-click and select Copy from the menu.
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Machining Browser: Copy an Operation - Premium
Configuration Shown

4. Now right-click on the toolpath again and select Paste.
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5. A copy of the toolpath will appear in the Machining Job below the original.

MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

6. Now select the second operation, right-click and select Rename.
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MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

7. The name of the operation will be activated for editing.  Change the name as desired and
then select anywhere outside of the name to accept the edit.  In this example, we
changed the name to 2 1/2 Axis Pocketing (Upper).

MILL Module shown, Similar for MILL-TURN,
TURN and Profile-NEST

8. Now left-click on the folder to the left of the copied operation and Drag it up until you see
a horizontal bar appear.  This line indicates to you where in the Machining Job tree the
operation will go if you release the left-mouse button.

When you see the horizontal bar appear above the operation where you want to move to,
release the mouse and the operation will move to that location.
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MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

9. Now right-click on the operation you just moved and select Edit to display the toolpaths
operation dialog.

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST
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10.   The remaining procedure is similar to How to Generate a Toolpath so we
will not show each dialog.   From the Control Geometry tab select the Remove All button
to remove the machining regions from this list.

11.   Now pick the Select Curve/Edge Regions button and the
dialog will minimize.

12. Select the face edges around the top perimeter of the upper pocket.  Note: If you press
the <Shift> key while selecting face edges, one left-click will select the entire chain of
face edges!  Then right-click or press <Enter> to continue.
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13. Pick the Cut Levels tab and change the Location of Cut Geometry to At Top.

14.   The remaining tabs and parameters can remain the so we pick Generate to
calculate the toolpath and display it on the screen.

15.   If you do not see the toolpath displayed, select the Toggle Toolpath Visibility icon
located at the bottom of the Machining Browser.

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST
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Create a Setup Sheet

You can generate a Setup Sheet for one or more toolpath operations.  There are several templates
available to choose from.  Each provides various degrees of information for the selected
operations.

To generate a Setup Sheet:

1. Create and adjust the toolpath operations that you want to estimate.  

2. Make sure the toolpaths have generated cleanly.  Each toolpath when generated is listed
under a Setup in the Machining Job.  If the operation is flagged it means that it needs to be
regenerated.

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

3. Select the Setup that you want to create a Setup Sheet for.  You can also select the
Machining Job.

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

4. Right-click and select Shop Documentation to display the dialog.
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MILL Module shown, Similar for MILL-TURN, TURN
and Profile-NEST

5. At the bottom of the dialog, select the Output Template to use.  The Excel Template will
display the Setup Sheet in a spreadsheet.  All other template selections will display the
Setup Sheet as an HTML page.

6. Enter a name for the Setup Sheet and pick Save.

7. The Setup Sheet is generated and displayed.  HTML pages are displayed in your default
web browser.  
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Create a Tool

Cutting tools can be created anytime before during or after your create a toolpath.  We have an
extensive guide just on cutting tools called The Cutting Tools Workbook that not only teaches you
about cutting tools but also provides worksheets for documenting the parameters you will need
from your existing tool bin to create those tools in VisualCAD/CAM.

To create a cutting tool:

1.   To the left of the Program tab, select the Tools Machining Objects icon to make sure
the Machining Objects Browser is displayed.

2. Select the Tools tab from the Machining Objects Browser.

3.   Select the Create/Edit Tools icon (first icon on the left) to display the Create/Select
Tool dialog.

https://mecsoft.com/blog/the-2018-cutting-tools-workbook-is-here/
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4.   The top toolbar lists the supported cutting tools.  Select the icon of the tool type you
want to create.  The dialog will populate with the Tool type's parameters.  For this
example we select the Ball Mill tool icon.

5. Edit the Name field to label your tool with a unique identifying name.  Tools are stored by
their name.

6. Edit the dimension fields to define the tool's physical characteristics including the tool
holder, such as diameter length, etc.  A preview of the tool will display in the dialog.

 

7. Move to the right side of the dialog and select the Properties tab.

8. Here, make selections and enter values to define the tool's properties.  Tool Material,
Number of Flutes, Tool Number, etc. are defined here.
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9. Coolant type can be assigned to each tool also.

10. If you want a comment to be posted in the G-Code file when the tool is used, enter it in
the Comments field.

11. Now select the Feeds & Speeds tab.  Here you can assign all of the Spindle Parameters and
Feed Rates that you want this tool to use.

12. If you are unsure what values to use, you can select the Load from File button to display
the Feeds and Speeds Calculator dialog.
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13. From here you will see that information about the Tool and Stock material are displayed. 
See How to Assign a Stock Material for more information.

14. This dialog is a reference calculator that you can use to suggest spindle speed and cut feed
rates based on multiple parameters and variables.  You will notice that changing
parameters and input variables in this dialog will update the Computed Variables section
at the bottom of the dialog including Spindle Speed and Cut Feed.  

NOTE: This dialog is only used as a reference to calculate a suggested value for Spindle
Speed and Cut Feed.  ALWAYS use values for these two parameters that are within
recommendations suggested by your machine tool vendor and your first-hand experience
with YOUR machine.

15. Pick OK when these two parameter values are to your liking for this tool. 

16. You will notice that the values for these two parameter values Spindle Speed and Cut
Feed are then fed into the Feeds & Speeds tab of the Create/Edit Tool dialog.
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17. You will also see that a percentages of the Cut Feed is used to populate the other Feed
Rate value in the Feed Rates section.  These percentages can be defined in the Feeds &
Speeds section of the CAM Preferences dialog.

18. You can also adjust the Feed Rate Reduction Factors if desired.

19. When you are satisfied with your tool parameters, select the Save as New Tool button. 
The new tool will be listed in the Tools in Session list on the left side of the dialog.

20. If you make changes after saving the tool be sure to select the Save Edits to Tool button to
save your changes.

21. Now pick OK to close the dialog.  You will see that the tool is then listed in the Tools tab
list of tools.
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22.   If you do not see your tool listed make sure the icon to List only tools used in
machining operations located at the bottom of the tools list is NOT enabled.

23. You can also create a tool from the Tools tab of each of the different toolpath operation
dialogs.  From the Tools tab, just select the Edit/Create/Select Tool ... button to top
display the Create/Select Tool dialog again.  See How to Generate a Toolpath for more
information.

Related Online Help Topics

User Interface

Tool

Create Edit Tools
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Create a Work Zero

When you zero your CNC machine for a job, you can tell VisualCAD/CAM where this Work Zero
location is.  Your G-Code coordinates will then be calculated from this location.  You can also have
multiple Work Zero locations defined in your part.  If no Work Zero is defined, then coordinates
are measured from the WCS origin of the part.

To Create a Work Zero:

1. Select the Program tab.

2.   Select Work Zero from the menu to display the dialog.

Dialog Box: Work Zero
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3. You have the option to Pick the Work Zero location.  Select Pick and then select the pick
button to select a point on the part.  Its coordinates are populated into the dialog.

4. Optionally you can select Set to Stock Box and then select from the three available options
Highest Z, Mid Z and Lowest Z.

5. Then select the Zero Position.  The nine locations to choose from.

6. Optionally you can also output the Work Offset Register.  To do so, check the box to
Output Work Offset and then accept the 54 value or change it.  This value will be posted to
your G-Code file as G54.

7. Pick OK and you will see the Work Zero added to the Machining Job.  

In the example shown below the Work Zero is set to the Stock Box, Highest Z, South West.

Related Online Help Topics

User Interface

Work Zero
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Define a Box Stock

You MUST define the Stock before creating a toolpath.  There are different stock menu selections
to choose from depending on your software configuration.  Here are the steps to create a simple
box stock.

1. Select the Program tab.

2.   From the Program tab, select the Stock menu.

3. Select Box Stock to display the dialog.

Dialog Box: Box Stock

4. The stock box will display on the part when this dialog is displayed.  
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5.   To create a stock with the exact dimensions of your part, select the
Copy Model Bounding Box button.

6. If you have curves or other non-part wireframe geometry displayed, you can check the box
in the dialog to ignore wireframe geometry in Bounds Calculation.

7. Alternately you can enter the Length, Width and Height dimensions of the stock you want
to use.

8. Select the coordinate location to measure the stock dimensions from.  By default stock
dimensions are measured from the bottom left corner of the part.
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9. You can also set the Corner Coordinates if desired.

10. Making changes in the dialog will update the stock preview on the part.

11. Pick OK to close the dialog.

12. You will see that the Stock is now defined under the Machining Job.

13.   The stock box will display on the screen.  If you do not see the stock displayed, pick
the Toggle Stock Visibility icon located at the bottom of the Machining Browser - first icon
from the left.

Related Online Help Topics

User Interface

Box Stock
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Define a Machine Tool

Before creating a toolpath make sure you have the Machine Tool definition set to the correct
Number of Axis and the axis directions defined.

1. Select the Program tab.

2.   From the Program tab, select Machine to display the dialog.
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Dialog Box: Machine Tool Setup - Manual Definition

3. From the Machine Tool Definition tab select Manual Definition.

4. For Machine Type, select the Number of Axis from the selection menu.

5. There are other General Parameters that you can set such as a Tool Change Point and
Translational Limits.

6. Check the box to Output all coordinates in local Setup Coordinate System.  This is typically
check by default.

7. If Machine Type is set to 4 Axis, check the 4th Axis (Primary) Parameters section of the
dialog and make sure the Rotation Center and Rotary Axis direction are set correctly.  An
axis indicator arrow (Green) will display on the part showing you this location and
direction.  You can also set the Rotary Axis Limit here.
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8. If Machine Type is set to 5 Axis, check the additional 5th Axis (Secondary Axis) Parameters
section of the dialog and make sure the Rotary Center and Rotary Axis direction are set
correctly.  An axis indicator arrow (Red) will display on the part showing you this location
and direction.

9. If Machine Type is set to 5 Axis and the parameter to Output all coordinates in local Setup
Coordinate System is NOT checked, make sure to set the value for Gage Length (For
machines with a Rotary Head).  This represents the distance from the head's rotary axis to
the spindle face.  This length value much match your machine in order for toolpath
coordinates to be output correctly. 

10. Pick OK to close the Machine Tool Setup dialog.

11. You will that the Machine is defined under the Machining Job.

Related Online Help Topics
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User Interface

Machine Setup
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Define the Post-Processor

VisualCAD/CAM installs with over 300 pre-defined post-processors for the most popular CNC
machine controllers.

1. Select the Program tab.

2.   From the Program tab, select Post to display the Set Post-Processor Options
dialog.

Dialog Box: Set Post-Processor Options

3. Select a Post from the Current Post Processor selection menu.

4. Each post in the menu has a corresponding post definition file (example: Haas.spm).  The
location of these files is displayed in the field directly below the menu called Folder
where post-processor files are located.
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5. Make sure this points to the correct folder where your post definition file is located.  To
change the folder location pick the ... button.

6. VisualCAD/CAM also comes with a Post-Processor Generator (PPG) that allows you to edit
each post definition file to suit your needs.  Select the Edit ... button to the right of the
Current Post Processor selection to load that post into the PPG.

7. IMPORTANT: If you edit a post definition file included with VisualCAD/CAM make sure you
use the Save As button from the PPG dialog and save your edited post using a unique file
name different than the pre-installed post name (example" Haas-REV1.spm) and save the
post definition file to a folder that is OUTSIDE of the VisualCAD/CAM install path.  This will
ensure that you will always have access to your modified posts even if VisualCAD/CAM in
upgraded or uninstalled.
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8. Then, from the CAM Preferences dialog, select the Post tab and then drop down the
Posted File Extension list and select the file extension that is required by your cnc
controller software (example .nc).  Your machine tool manual will tell you what file
extension is required.  If your file extension is not on the list, pick the Add New ... button
to add it to the menu.

9. If you use a G-Code Editor program, you can tell VisualCAD/CAM to launch it when
displaying your G-Code files.  By default, notepad is used to display G-Code files.  See How
to Post G-Code for more information.

10. You can also set file naming conventions to use when posting your G-Code files.

11. When done pick OK to close the menu.

12. You will see that the Post is now defined under the Machining Job.
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Related Online Help Topics

User Interface

Set Post Options
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Define Toolpath Properties

You can set the properties of a Operation by selecting it in the Machining Browser window,
clicking on the right mouse button and selecting the Properties menu item.

Select Properties from the Right-click Menu

Select Properties from the Right-click Menu
Note: MILL Module shown, Similar for MILL-TURN,

TURN and Profile-NEST

Dialog Box: Machining Operation Properties

This will bring up the dialog that is shown below.

https://youtu.be/isLhHqrbh4Y
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Dialog Box: Machining Operation Properties

Name  
Change the Name of the Machining Operation.  

Program #  
Specify Program # for the operation.  This program number will be output during post
processing of the operation.

Simulation Color  
This allows you to specify a unique color for this operation during Simulation display. 
Refer to the Simulate tab Status Bar for setting the simulation to display by Mop (i.e.,
machining operation type).

Comments to Output  
You can also include commands that will be saved with the operation.  These comments
will also be output during post-processing of the operation.  This might be a good place
to put in comments or instructions for the machine tool operator.

This can be used to put in add comments or instructions for
the machine tool operator!

Previously Output To File  
This refers to the name of the external post-processed file that this particular operation
was output to.

Previously Output On  
This refers to the last time the operation was post-processed and the time the post-
processing was performed.



Edit Toolpaths Associatively 71

© 2026 Mecsoft Corporation

Edit Toolpaths Associatively

Machining Operations can be edited by using the Machining Browser.  Each machining operation is
represented as a folder in the browser.  In the expanded state of this folder icon, seven icons
representing different objects that make up the operation are displayed.  The first five can be
associatively edited.

The Machining Operation Tree Icons

The following icons are displayed under a machining operation's folder and represent
the different objects that make up the operation.  The first five (Machining Features,
Tool, Feeds/Speeds, Clearance Geometry, Parameters, Toolpath Viewer/Editor and G-
Code Editor) can be associatively edited.

Machining Features

Tool

Feeds/Speeds

Clearance Geometry

Parameters

Toolpath

 G-Code Editor

In-process Stock

Double Click to Open a Machining Operations Dialog for Editing

Double clicking on the operation folder (or name) will open the operation's properties
dialog with all tabs displayed for editing.
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Double Click to Open the G-Code Editor module
Note: MILL Module shown, Similar for TURN and

Profile-NEST

Right or Double Click one of an Operation's Icons to Edit its Properties

Right mouse click or double clicking a specific icon, for example the Tool icon would
bring up the Tool Creation dialog, upon which you can substitute the current tool with
another or edit the parameters of the current tool.

Click on this Icon Displays the Operation's

Control Geometry tab

Tool tab

Feeds/Speeds tab

Clearance tab

Cut Parameters tab(s)

Toolpath in the Toolpath Viewer

Launch the G-Code Editor with the
latest posted g-code loaded.

If flagged, simulate the operation.
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Right or Double Click one of an Operation's Icons to Edit
its Properties

Note: MILL Module shown, Similar for TURN and
Profile-NEST

Drag & Drop a Tool from the Object Browser to an Operation

The tool can also be edited by dragging and dropping a tool from Tools tab to the
Machining Browser.
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Drag & Drop a Tool from the Object Browser to an Operation
Note: MILL Module shown, Similar for TURN and Profile-NEST

Display of Operations that need Regenerating after Editing

If any of the objects that make up the operation were to be edited after the toolpath was
initially generated, the operation will be flagged dirty (i.e., needing regeneration).  This

condition is indicated by adding a red marker  to the operation folder.  Also, the

object that necessitated this condition  is also displayed with a red marker.

An example of this is shown below. In this case the tool used in the operation was edited
after the machining operation was created and so is shown differently, as is the
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operation.

Display of Operations that need Regenerating after Editing
Note: MILL Module shown, Similar for TURN and Profile-NEST

Mops will be flagged if any associated parameters outside of the operation are edited. 
For example, if the Stock is modified, any Roughing operations dependent on that Stock
will be flagged for regeneration.

Note: MILL Module shown, Similar for TURN and Profile-NEST

Regenerating "Flagged" Machining Operations
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In order to regenerate the operation that is flagged with a red marker, you would have to
select the operation, right click and select Regenerate.

Right-click on an Operation and Select Regenerate
Note: MILL Module shown, Similar for TURN and Profile-NEST

The toolpath is now generated with the modified settings.

Machining Operation is Regenerated
Note: MILL Module shown, Similar for TURN and Profile-NEST
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Enable Cutter Compensation

All toolpaths except engraving are automatically compensated for the tool geometry.  Cutter
compensation is used typically to compensate for the difference in the dimensions of the actual
cutter used in machining and the cutter used for programming in VisualCAD/CAM.  For example, if
the cutter used in programming is 0.25 inches and due to tool wear the actual cutter is only 0.24
inches in size, you can compensate for this at the controller rather than having to re-program the
operation in VisualCAD/CAM.  

Cutter compensation is used extensively in production (high volume) machining where the
machine operator can compensate for tool wear before having to stop and replace the tool or
insert.

In order to do this the user needs to do the following:

1. Turn cutter compensation on in the operation to Auto/ON or CONTROL/ON.

2. Specify the cutter compensation value and the compensation register in the controller
(the controller needs to be capable of doing this).

3. Please make sure the post processor is configured to output cutter compensation. This is 
defined under the Cutter Compensation section in the post processor generator. Most
controllers expect an X & Y motion on the same line as cutter compensation.

Cutter Compensation Left

[SEQ_PRECHAR][SEQNUM] G41 [G_CODE] X[NEXT_NONMDL_X] Y[NEXT_NONMDL_Y] D[TOOL_CUTCOM_REG]

Cutter Compensation Right

[SEQ_PRECHAR][SEQNUM] G42 [G_CODE] X[NEXT_NONMDL_X] Y[NEXT_NONMDL_Y] D[TOOL_CUTCOM_REG]

Cutter Compensation Off

[SEQ_PRECHAR][SEQNUM] G40
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A few things to watch out for:

1. Cutter compensation makes sense only in 2-1/2 axis operations.  If you are using roughing
(pocketing & facing) the compensation will be turned on only in the final passes.

2. Make sure you are using Climb or Conventional cut traversal in any of the methods that
you want to turn compensation on.

3. Make sure you have a linear motion for the controller to turn on the compensation for.  If
your first motion is an arc the controller will not be able to turn on the compensation. 
Thus, in 2-1/2 axis profiling, make sure there is a linear entry motion for the controller to
be able to turn compensation on & linear exit to turn off compensation.
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If you are looking to compensate for the full tool diameter, set Stock = -0.125 under the cut
parameters tab. (0.125 being the radius of the tool). This would generate the toolpath ON the
curve. This would invalidate the simulation as the tool tip stays on the drive geometry.

Note:  The Cutcom Register is set under the Create/Select Tool definition dialog.
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Enable Inverse Time Feedrate in 4 Axis

You do not need to edit your toolpath operations to output the Inverse Time Feedrate format!  It
is done automatically once it is enabled in your post processor.  Follow these steps to enable the
Inverse Time Feedrate format in your post:

1. From the Program tab under Machine Setup, select the Post icon to display the Set Post-
Processor Options dialog.

2. For Current Post Processor, select your post.

3. Pick the Edit button to the right.  This will display the Post-Process Generator dialog.

Launch the Post-Process Generator

4. From the left side pane, select the Feedrate section.

Post-Process Generator / Feedrate / Inverse Time

5. On the right side pane, under Block Format, check the box next to "Output inverse time
feedrate for 4 & 5 Axis motions".

6. For On Code, enter G93.
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7. For Off Code, enter G94.

8. Pick Save As to save your (*.spm) post.  

Anytime you make an edit to your post (*.spm) file, it is recommended that you
select Save As to save your post file to a unique name and to a unique folder where

you can find it (such as your Desktop or shared Network Drive).

9. With your revised post set as your Current Post Processor, pick OK to close the Set Post-
Processor Options dialog.

If you do not see your revised post in the Current Post Processor list, select the "..."
button to the right of "Folder where post processor file are located" and navigate to

the folder where you save your post (*.spm) file.  It should then appear in the list.

10. Test the revised post with a sample 4 or 5 Axis toolpath operation.
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Estimate Machining Time

You can calculate the estimated machining time for one or more toolpath operations.  The time is
calculated based on the Cut Feed and Transfer Feed rates assigned to each operation.  Understand
that the machining time is an estimate.  It does not take into account any physical or limiting
factors of your CNC machine or controller settings.  See our blog article Optimize Machining Time
Estimates! for additional reading.

To calculate the estimated machining rime:

1. Create and adjust the toolpath operations that you want to estimate.  

2. Make sure the toolpath has generated cleanly.  Each toolpath when generated is listed
under a Setup in the Machining Job.  If the operation is flagged it means that it needs to be
regenerated.

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

3. Select the operation that you want to estimate.  You can select multiple operations by
pressing the <Ctrl> key while selecting.  You can also select an entire Setup or the entire
Machining Job.

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

4. Right-click on the selected operation(s) and select Information to display the dialog.

https://mecsoft.com/blog/optimize-machining-time-estimates/
https://mecsoft.com/blog/optimize-machining-time-estimates/
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Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

5. Each selected operation is listed.  The estimated machining time is shown in the right side
column along with the total time for all listed operations.

6. Select the Print button to print the report if desired.

7. Pick OK to close the information dialog.
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Find Tool Related Preferences

Listed below are the CAM Preferences that are related to Tools and Tool Libraries:

1. Locate the CAM Preferences icon to the right of the Program tab and select it.

2. Select the User Interface item from the left.  Here are a couple of Preferences that will
help you with the tools related dialogs:

Show context ToolTips

Check this box to display Context ToolTips when the mouse moves over a parameter in a
dialog.  A definition of the parameter will pop-up automatically.  Note that Context
ToolTips may not be available for ALL dialogs.  You can also set the ToolTip Delay in
seconds.  This is the amount of time it takes to display the Context ToolTip when the
mouse activate it.

Show Expressions in Tooltip

You can enter expressions in any dialog field that expects a numerical value and the value
will be computed and entered automatically.  Check this box to pop-up the results of any
expressions in a ToolTip balloon.  An example is shown below.

Show Expressions in ToolTip

3. Select the Cutting Tools item from the left.
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CAM Preferences > Cutting Tools
Note: Menu selections on the left may change depending on module and

configuration

4. You can select the Default Tool Library to load for new part files.  You can also check
the box to Load the last loaded tool library on startup.  This will ensure that your Tool
Library loads every time the program runs.

5. You can also set Tool related colors on this dialog.

6. Now select the Feeds & Speeds section from the left.

7. Here you can decide if you want default Feeds & Speeds loaded from the Tool for new
operations.  If you set this to Tool and define your Speeds & Feeds for each of your
tools, you can be sure those Feeds & Speeds are being used when a new operation is
created that uses that tool.
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CAM Preferences > Feeds & Speeds

8. You can also set the % of the computed Cut Feed to use for the various types of
transfer motions.  For example, in the Feeds & Speeds Calculator (displayed when you
select Load from File from either the Create/Select Tools dialog or from the Feeds &
Speeds tab of any operation type) a Cut Feed value is calculated and suggested. 
These percentages listed in this CAM Preferences dialog will determine how much of
that Cut Feed value is used for each of they remaining tool motion types. 

9. You can also check the box to Always track Operations Feeds/Speeds to used Tool. 
When this is checked, changing the feeds/speeds parameters of a tool and saving the
edits, will automatically update the feeds/speeds on each operation that utilizes this
tool in addition to marking the operations as dirty.
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Generate a Toolpath

VisualCAD/CAM includes many toolpath operation types to choose from depending on your
software configuration.  Also each operation type has default parameters predefined to allow you
to quickly create a toolpath and view the results.

Here are the basic steps to create a toolpath:

1. Open a part or drawing file or create the geometry that your wish to create a toolpath for. 
2 Axis operations can be created with 2D or 3D geometry.  3 Axis operations require
surface and/or mesh geometry.  Some 4 Axis operations require 3D solids or surfaces only.
 All and 5 Axis operations require 3D solids or surfaces only.  You must have visible
geometry in your part file to create a toolpath.

In this example we will generate a 2 Axis Pocketing toolpath to machine the bottom
pocket in this 3D solid model.

2. Perform the steps needed to setup your part.  These include defining your Machine, Post
and Stock.  You must first have geometry and Stock defined to create a toolpath.

3. Select the Program tab.

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST
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4. Decide what type of toolpath to create and select the operation type from the menus on
the Program tab.  Depending on your software configuration, you can select from the 2
Axis, 3 Axis, 4 Axis or 5 Axis menus.  The operation dialog for that toolpath type will
display.  

5.   For this example we will generate a 2 Axis Pocketing toolpath so select the 2
Axis menu.

6.   Select Pocketing from the menu to display the dialog. 

7. The dialog has several tabs at the top.  The Control Geometry tab is displayed first.  Use it
to select your machining regions.  All 2 Axis operations require that you select machining
regions.  In 3 Axis and 4 Axis operations machining regions are used to if you want to
contain the toolpath but are not required for all 3 and 4 Axis operations.  5 Axis operations
do require machining regions.  

8. The buttons on this tab are used to select your machining regions.  Here we will pick the
Select Flat Area Regions button.
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9. The dialog minimizes and you are prompted to select a flat area.  We select the bottom of
the inner pocket and then right-click or press <Enter>.

10. The dialog reappears with the selected machining regions listed.  They are also
highlighted on the part.

There are other ways to define and select machining regions.  You can pick Help from the
dialog to learn about each button option. 

11. Select the Tools tab and select a tool from the Tools list or select the Edit/Create/Select
Tool ... button to create a tool.  You must select a tool to create a toolpath. 
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12. Select the Feeds & Speeds tab and set the Spindle Speed and Feed Rates for the operation
and use the Load from Tool ... or Load from File ... buttons.  The Load from File ... button
displays the Feeds & Speeds Calculator to assist you will selecting feeds and speeds
values for the operation.

13. Select the Clearance Plane tab and adjust if desired.
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14. Now we will select the Cut Parameters tab of the dialog and make the following
adjustments.  Stock will leave 0.01 remaining on the side walls.  The cut pattern will offset
the perimeter of the pocket.  The cut will start in the middle of the pocket, offset outward
at a stepover 0.01 and perform a cleanup pass at each cut level.

Tolerance : 0.001
Stock : 0.01
Cut Pattern : Offset
Cut Direction : Climb
Start Point: Inside
Stepover Distance : 0.12
Corner Cleanup Loops : None
Cleanup Pass : Checked
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15. Next we select the Cut Levels tab.  All 2 Axis operations require your to adjust the Cut
Levels tab to control the depth of cut.  In all 3, 4 and 5 Axis operations your part surfaces
will limit the maximum depth of cut. 
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16. First make a selection to define the Location of Cut Geometry.  In our example we select
At Bottom because the machining regions we selected lie at the bottom of the pocket.  If
they lie at the top we would select At Top.  If they do not lie either at the top or the
bottom of the pocket you can use the Pick Top option to define the top of the cut.

17. Next we move to the Cut Depth Control section.  If you know how deep the pocket should
be just enter the depth in the Total Cut Depth field.  This is always an absolute value (i.e.,
no negative numbers).

18.   In our case we do not know the exact depth without manually measuring the
geometry so we will select the Pick button.
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19. The dialog minimizes and prompts us to select s start point and an en end point to define
the Total Cut Depth.  We select the top and bottom floor of the pocket and then right-click
or press <Enter>.

20. The dialog reappears with the Depth of Cut calculated for us.

21. Notice that the value in the Rough Depth field is now the same as the Total Cut Depth. 
You have the option to split the Total Cut Depth into a Rough Depth and a Finish Depth. 
We will enter 0.05 into the Finish Depth field and then press the <Tab> key (or simply
activate another field.

22. We see that the Rough Depth value is now reduced by 0.05.  The Rough Depth and Finish
Depth values will always equal the Total Cut Depth value.  You can also use the slider to
split these values up.

23. You will also notice now that the Rough Depth/Cut and Finish Depth/Cut fields are
populated with the save values.  If we generate the pocket toolpath right now, there
would be one rough level cut and one finish level cut.
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24. We can add additional cut levels by entering 0.03 in the Rough Depth/Cut field and
entering 0.01 in the Finish Depth/Cut field.  This will produce 4 rough cut levels at the top
of the pocket and 5 finish cut levels at the bottom of the pocket.

25. With our cut levels defined we select the Pocket Entry/Exit tab of the dialog.

26. Now we select the Pocketing Entry/Exit tab to control how the cutter will enter and exit
the part and make the following selections:

Approach Motion Length (L) : Default (0.025)
Engage Motion :  Helix
Helix Radius (R): Default (0.0625)
Retract Motion : Linear, Length: 0.0625, Angle (A): 45
Departure Motion : Vertical Distance (D): Default (0.025)
Apply entry/exit at each cut level : Checked
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27. Now we will select the Advanced Cut Parameters tab and make the following selections. 
The parameters available on this tab will depend of the type of toolpath operation and
your software configuration.

Perform Arc Fitting : Checked
Fitting Tolerance (t) : 0.002
Use Smooth Cut Connections : Checked
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With these selections full and partial arc motions will be generated within the Fitting
Tolerance (t) we have specified.  There will also be smooth cut connections between
stepover paths.  These advanced parameters will reduce the torque stress on your CNC
machine and also reduce tool deflection, prolonging tool life.  

28. Since we only have one pocket we do not need to look at the Sorting tab.

29. Now were ready!  Select the Generate button at the bottom of the dialog to generate the
2 Axis Pocketing toolpath and display it on the screen.

30. It is also listed in the Machining Job.
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31.   If you do not see the toolpath displayed, select the Toggle Toolpath Visibility icon
located at the bottom of the Machining Browser.

32. Let's have a closer look at the toolpath.
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Load a Tool Library

You can have multiple tool libraries saved.  This is useful when archiving tools by type or by stock
material, etc.  You can then load a tool library at any time.

1.   To the left of the Program tab, select the Tools Machining Objects icon to make sure
the Machining Objects Browser is displayed.

MILL Module Shown, Similar for TURN, MILL-TURN and
Profile-NEST Modules

2. Select the Tools tab from the Machining Objects Browser.

MILL Module Shown, Similar for TURN, MILL-TURN and
Profile-NEST Modules

3.   Select the Load Tool Library icon to display the Open dialog.

4. Navigate to the folder where your tool library file is saved.  Select the file and pick Open.

5. You will see a message alerting you that tools are being loaded from a library.  Pick OK and
all tools in the library are loaded into the current part file and the tools are listed in the
Tools list of the Tools tab.
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6. If you have tools already created in this part file they are not removed.  The tools in the
library are just added to your Tools list. 
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Load a Tool Library Automatically

If you have a Tool Library file saved and you want this tool library to load each time you create a
new part file:

1. First make sure you have a Tool Library saved.  See How to Save a Tool Library for more
information.

2.   Select the CAM Preferences icon located at the top-right of the Machining Objects
Browser (i.e., to the far right of the Program tab) to display the dialog.

MILL Module Shown, Similar for TURN, MILL-TURN and
Profile-NEST Modules

3. From the left side of the dialog select Cutting Tools.

CAM Preferences > Cutting Tools
Note: Menu selections on the left may change depending on module and

configuration

4. Check the box to Always load last loaded tool library on start up.

5. From the Default Tool Library section of the dialog, pick the ... button to display the Open
dialog.
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6. Navigate to the folder where you tool library lie is saved.  Select the file and pick Open.

7. The folder path and file name are then listed in the Default Tool Library field.

8. Pick OK to close the CAM Preferences dialog.

9. This Tool Library will now load automatically when you create/open a new part file. 
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Load the Default Tool Library

VisualCAD/CAM includes a pre-defined tool library of both Inch and Metric tools that you can use
to start your own tool library.  

To load this tool library:

1.   To the left of the Program tab, select the Tools Machining Objects icon to make sure
the Machining Objects Browser is displayed.

MILL Module Shown, Similar for TURN, MILL-TURN and
Profile-NEST Modules

2. Select the Tools tab from the Machining Objects Browser.

MILL Module Shown, Similar for TURN, MILL-TURN and
Profile-NEST Modules

3.   Select the Load Tool Library icon to display the Open dialog.

4. From the Open dialog set the file type to Tool Library Text Files (*.csv).

5. Navigate to C:\ProgramData\MecSoft Corporation\VisualCAM 2026\Data.

6. There are two tool libraries in this folder:

DefaultEnglishTools.csv
DefaultMetricTools.csv

7. Select the tool library to load and pick Open.

8. You will see a message alerting you that tools are being loaded from a library.  Pick OK and
all tools in the library are loaded into the current part file and the tools are listed in the
Tools list of the Tools tab.
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MILL Module Shown, Similar for TURN, MILL-TURN and
Profile-NEST Modules

9. If you have tools already created in this part file they are not removed.  The tools in the
library are just added to your Tools list.
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Orient a Part for Machining

VisualCAD/CAM includes an Orient Part command to help you quickly change the part orientation
for machining.

1. Open the part file you wish to orient.

2. Select the Program tab.

2.   From the Program tab, select the Setup menu.

3.   Select Orient Part to display the dialog.
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Dialog Box: Orient Geometry

4. From the Set Look Down Direction section of the dialog, select the direction you want to
machine.  While this dialog is displayed, the machining axis will display on the part.  The Z
Axis (Blue) should point toward the direction you want to machine.
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5. Pick OK and the part will be re-oriented with that direction facing the positive Z axis.

6. There are other options on this dialog to help you orient the part.  Select the Help button
to learn about them.

Related Online Help Topics

User Interface

Orient Part, Setup
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Post G-Code

Once machining operations are created they can be post-processed to a specific machine
controller. To post-process a machining operation, select the operation in the browser, right click
and select Post.  The product comes with a set of over 300 post-processors to choose from.  The
current post-processor and g-code is also stored with the Part file.  The current post-processor and
latest G-Code is stored with the part file for better CAM Life-cycle Management. 

How your Post-Processor is Stored

When you set the current post-processor for your Machining Job it is saved with your part
file when the file is saved.  This keeps the post-processor used to generate your g-code
associated with your part file for better CAM Life-cycle Management. 

The Current Post-Processor is stored with your Part File

How G-Code is Stored

When you post-process a machining operation from the Machining Job, the G-Code data
is also saved with your part file when the file is saved.  This keeps all cam data together
for better CAM Life-cycle Management.  If you see that the G-Code icon is flagged, it
means that the latest G-Code has not been captured.  Regenerate the operation and the
flag will be removed.
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The G-Code Item within the MOp Folder

Editing G-Code from the MILL module

You can view or edit your G-Code from an operation that you have generated by simply
clicking on the G-Code icon within the mop folder.

G-Code Browser: Tool Crib menu item

The Machining Browser will be replaced with the Edit tab of the G-Code Editor module. 
To return to the MILL module pick the left arrow icon at the top of the G-Code Editor
browser.  For documentation on using the G-Code Editor Edit tab click on the "?" help
icon located at the top right side of the G-Code Editor browser.



VisualCAD/CAM 2026 Q&A Guide110

© 2026 Mecsoft Corporation

G-Code Browser: Tool Crib menu item

Steps to Manually Post G-Code

1. Create and adjust the toolpath operations that you want to post G-Code for.

2. Make sure the toolpaths have generated cleanly.  Each toolpath when generated
is listed under a Setup in the Machining Job.  If the operation is flagged it means
that it needs to be regenerated.  

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

3.   From the Program tab, select Post to display the dialog.
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Note: MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

Dialog Box: Set Post-Processor Options

4. Select a Post from the Current Post Processor selection menu.  See How to
Define the Post-Processor for more information.

5. Make sure you have simulated each toolpath and are satisfied with each toolpath
operation.  See How to Simulate a Toolpath for more information.

6. Select the operation that you want to post.  You can select multiple operations by
pressing the <Ctrl> key while selecting.  You can also select an entire Setup or the
entire Machining Job.
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Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

7. Right-click on the selected operation(s) and select Post to display the dialog.

Note: MILL Module shown, Similar for MILL-TURN, TURN
and Profile-NEST

8. Your Current Post is listed at the bottom of the dialog.  You can change it here if
desired.

9. Navigate to the folder where you want the posted G-Code file to be saved.

10. Adjust the name of the G-Code file if desired.

11. Make sure the file extension (example: .nc) of the G-Code file is correct and that
your CNC machine controller will read this file extension.  Refer to your
controller manual for this information.

12. Select the Post button and the G-Code file is calculated and displayed.  
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13. G-Code files are ASCII Text Files and by default, are displayed in notepad, a
windows generic text editor.

14. You can review the G-Code and make any manual edits if needed and save the
file from notepad.

15. If you use a different text and G-Code editor program, you can tell
VisualCAD/CAM to display your G-Code files in this program.  To do this select
Post from the Program tab to display the dialog.

16.   In the section of the dialog were it says Program to send posted file to select
the ... button to the right to display the File Open dialog.

17. Locate the .exe program that you use to edit your G-Code files with and then
press Open.

18. Then pick OK to close the Set Post-Processor Options dialog.
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Print a Tool List

Follow the steps outlined below to print your Tool List:

1. The Tool List is based on the tools currently listed under the Tools tab of the Machining
Objects Browser.  If you want to print your tool library list, first Load your Tool Library so
that all of your are listed in the Tools tab.  See Create a Tool Library to learn how to Load
your Tool Library.

2. From the Tools tab, select the Tool List icon:

MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

3. From the Cutting Tools Information dialog, pick the Print button.
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Save a Knowledge Base

VisualCAD/CAM includes powerful Knowledge Base functionality that makes "push button"
programming a reality. You can archive an entire machining strategy specific to a certain class of
parts in a Knowledge Database (also referred to as a K-Base) and then optionally assign Geometry
Selection Rules that are applied automatically when toolpath operations are selected for use from
the Knowledge Base. 

1. Create and adjust the toolpath operations that you want to include in your knowledge
base.  

2. Make sure the toolpath has generated cleanly.  Each toolpath when generated is listed
under a Setup in the Machining Job.  If the operation is flagged it means that it needs to be
regenerated.

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

3. Make sure you have simulated each toolpath and are satisfied with each toolpath
operation.

4. Select the operation that you want to save to the Knowledge Base for.  You can select
multiple operations by pressing the <Ctrl> key while selecting.

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

5. Right-click on the selected operation(s) and select Save to Knowledge Base.
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Note: MILL Module shown, Similar for MILL-TURN, TURN
and Profile-NEST

6. The Save As dialog is displayed and automatically navigates to the Defaults folder for
VisualCAD/CAM.  Enter a name for the Knowledge Base file and pick Save (Example:
My_Knowledge_Base.vkb)

7. Only one Default Knowledge Base can be loaded at a time. However, you may want to use
multiple different Default Knowledge Base files.  

  To change the Default Knowledge Base select the CAM Preferences icon from the
Machining Objects Browser to display the dialog.

Note: MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

8. Select Machining from the left to display the Machining Preferences.
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CAM Preferences: Machining

9. From the Default Parameters section select the Default Knowledge Base to use from the
menu.  If you have saved different Default Knowledge Base into the Defaults folder, they
will be listed here.

10. If you set this to Undefined, the factory defaults are used when creating an operation.
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Save a Tool Library

Creating a tool only assigns that tool to the part file you are editing at the time.  To use your tools
repeatedly for other part files you need to create a tool library.

1. Open the part file that contains tools that you want to save to a library.

2.   To the left of the Program tab, select the Tools Machining Objects icon to make sure
the Machining Objects Browser is displayed.

MILL Module Shown, Similar for TURN, MILL-TURN and
Profile-NEST Modules

3. Select the Tools tab from the Machining Objects Browser to see your list of tools.

4.   From the toolbar below the Tools tab select the Save Tool Library icon.

5. From the Save As dialog that displays, enter a File Name for the tool library.

6. Select a folder where you want the tool library file saved.

7. By default tool library files are extended with a *vkb file extension. 

8. Pick Save to save the file.
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Save Defaults

VisualCAD/CAM can save all of your machining parameters as default settings so that they are
loaded automatically each time you create the same toolpath operation.  This is your first step
toward toolpath automation.

1. Create and adjust the toolpath operations that you want to save defaults for.  

2. Make sure the toolpath has generated cleanly.  Each toolpath when generated is listed
under a Setup in the Machining Job.  If the operation is flagged it means that it needs to be
regenerated.

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

3. Make sure you have simulated each toolpath and are satisfied with each toolpath
operation.

4. Select the operation that you want to save defaults for.  You can select multiple
operations by pressing the <Ctrl> key while selecting.

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

5. Right-click on the selected operation(s) and select Save as Defaults.
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Note: MILL Module shown, Similar for MILL-TURN,
TURN and Profile-NEST

6. The Save As dialog is displayed and automatically navigates to the Defaults folder for
VisualCAD/CAM.  Enter a name for the defaults file (for example:
My_Default_Parameters.vkb) and pick Save.

7. The defaults are saved as the Default Knowledge Base file with a .vkb file extension and
the CAM Machining Preferences are set automatically to use this Default Knowledge Base
file.  

8. Only one Default Knowledge Base can be loaded at a time. However, you may want to use
multiple different Default Knowledge Base files.  

  To change the Default Knowledge Base select the CAM Preferences icon from the
Machining Objects Browser to display the dialog.

9. Select Machining from the left to display the Machining Preferences.
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CAM Preferences: Machining

10. From the Default Parameters section select the Default Knowledge Base to use from the
menu.  If you have saved different Default Knowledge Base into the Defaults folder, they
will be listed here.

11. If you set this to Undefined, the factory defaults are used when creating an operation.
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Set Preferences at Start Up

The steps below will assist you in making sure the correct preferences are loaded at start up.  

Important: When you install the plug-in (near the end if the installation) the program will ask you

if you want to use your existing settings. Make sure you say YES.  If you said NO, or if your

preferences have changed without your knowledge, then follow the steps below to recapture

your preferred settings manually. 

To open new files using a default template file:

1. Open an existing file that has your settings defined (i.e., post, tool library, etc.).

2. Save the file and the settings will update in the Windows registry.

3. As a check, open a new file and go to the Program tab > Post and look at the Select Post-

Processor dialog.

4. Make sure your correct post is selected.  If not, use the ... button to browse and select the

folder where you post is and pick OK and then OK again.

5. For new files you can open the Template file.  If not, that's OK, RhinoCAM/VisualCAM will

load with your settings.

To load a default Tool Library at start up:

1. Check the Tools tab.  If your tools are not loaded by default, go to the CAM Preferences

dialog (Machining Browser > CAM Preferences (the gear icon at the right side of the

browser)) and go to the Cutting Tools tab.

2. Use the Tool Library Preferences section, make sure your tool library is listed in the

Default Tool Library field.  If not, use the ... button to locate your tool library and pick OK

and then OK again.

To load a default Knowledge Base:

1. If you have a default knowledge base, go to CAM Preferences and from the Machining tab

make sure your knowledge base is selected from the Load from Knowledge Base drop-

down menu.  If not, highlight and copy the source folder for knowledge bases.  Then open

the windows file browser and navigate to that folder and copy your knowledge base file to

that folder.

2. Now close and reopen the CAM Preferences tab and make sure your default KB is selected

and pick OK.
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General options for handling your CAM Preferences:

1. Open or start a new file and make sure your preferences are correct.

2. Go to the CAM Preferences dialog by selecting the gear icon from the Machining Browser

(top-right and to the left of the help ? icon).

3. Select the User Interface tab.

4. There 4 options under the Save Preferences section.

5. Un check the third check box and the large button that says "Always save current

preferences to registry on exit" will be activated.

6. Select this button and all of your current preferences will be saved to your Windows

registry.

7. Test this by closing and reopening RhinoCAM/VisualCAM and your default preferences

should load by default.

8. The three check boxes are self-explanatory. Use them to set how preferences are

loaded/saved.
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Setup a Part

To setup a part for machining perform the following basic steps.  These are similar for all types of
parts.

1. Check and know the part units (Inches/Millimeters).  Only these two units are supported
in CAM.

2. Check the orientation of the part to make sure it can be machined.  By default the Z axis is
the machining direction.  Typically the X axis points toward the right or along the bed of
the CNC machine.  The Y axis typically points to the back of the CNC machine.

3. See How to Orient a Part for Machining for a quick way to orient the part.

4. Select the Program tab.

5.   Set the Machine definition to either 3, 4 or 5 axis depending on your machine
tool and part requirements.

6.   Set the Post-Processor definition.

7.   Define your stock size and material.

8.   Align the Stock with the Part if needed.

9.   By default the program zero will be measured from the WCS (World
Coordinate System).  You can create an alternate Work Zero location if needed.



Simulate a Toolpath 125

© 2026 Mecsoft Corporation

Simulate a Toolpath

VisualCAD/CAM allows you to simulate your toolpath to see the cut material removal and in-
process stock.

Here are the basic steps to simulate a toolpath:

1. First create a toolpath to simulate and make sure the toolpath has generated cleanly.  Each
toolpath when generated is listed under a Setup in the Machining Job.  If the operation is
flagged it means that it needs to be regenerated and cannot be simulated yet.

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

2. From the Machining Job, select the operation that you want to simulate.

Note: MILL Module shown, Similar for
MILL-TURN, TURN and Profile-NEST

3. Select the Simulate tab.  Its located to the right of the Program tab.
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Note: MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

4.   Pick the Play button to run the simulation.

5.   You can toggle off the toolpath to see the resulting in-process stock model by
selecting the Toggle Toolpath Visibility icon from the base of the Machining Browser.

6. You can slow down the simulation by adjusting the slider located on the Simulate tab
menu.  You can further slow down the simulation by un-checking Simulate by Moves from
the Simulate tab menu.
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Note: MILL Module shown, Similar for MILL-TURN, TURN and
Profile-NEST

7.    You can fast-forward to the end of the simulation by selecting Pause and
then To End.

8.   To see each cut motion one at a time, you can select the Step button.

9.   You can set simulation preferences by selecting Preferences from the
Simulate tab menu.

10.   You can apply a Stock Material texture to the simulation by selecting the Toggle
Material Texture Visibility icon from the base of the Machining Browser.

11. If the in-process Stock does not display on the screen during the simulation, make sure
you have simulated all previous operations that appear in the Machining Job.
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Suppress a Toolpath

You can Suppress a machining operation or a Setup in the Machining Browser by selecting it, right
click and select Suppress from the context menu.  Suppressed operations will not be displayed,
posted or simulated.  You can also right-click and Unsuppress an operation.  Note: You can
customize how suppressed operations are managed using the Machining Preferences dialog.

To Suppress an Operation

To Suppress an Operation
MILL Module shown, Similar for MILL-TURN, TURN and

Profile-NEST

The Suppressed Operation Icon

A Suppress operation will display in the Machining Job with the following icon:
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Suppressed Operation Icon
MILL Module shown, Similar for

MILL-TURN, TURN and Profile-NEST

To Unsuppress an Operation

To Unsuppress an operation, right-click on it and select Unsuppress. 

To Unsuppress an Operation
MILL Module shown, Similar for MILL-TURN, TURN and

Profile-NEST
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Use these help topics

These How To ... help topics are quick answers to some of the many questions you will have as a
new user starting out.  They are arranged in the order that is typically used to create and work
with toolpaths in VisualCAD/CAM.  Here are some suggestions on how to use these topics:

1. If you are new to VisualCAD/CAM, we suggest that you first take some time to complete
the Quick Start Guide.  It walks you through the basic procedure to create a toolpath.  See
the Videos & Guides topic for more information.

2. Next, take some time to read through all of these How To topics.  The topics are short,
providing quick information.

3. Then refer back to a specific topics later as you need to refresh your skills.

4. Remember that each dialog in VisualCAD/CAM has a Help button that you can select to
display the online help for that dialog.
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Why are my Feed Rate values too High/Low?

If your Feed Rate values in your posted g-code are too High or too Low, you can adjust the
High/Low parameters in the Post Processor following the steps outlined below:

1. Click on Post (Set Post-Processor Options), then click Edit.

Note: MILL Module shown, Similar for MILL-TURN, TURN and Profile-NEST

2. From the Post Processor Generator dialog, select the Feed Rate tab from the left.

3. Then make the necessary changes under the Feed Rate Value section for either the High
Value or Low Value.

4. Then pick Save.
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